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Evaluation board/kit and Development tool important notice
1. This evaluation board/kit or development tool is designed for use with engineering evaluation, demonstration, or development purposes only. Do not use it for other purposes. It is not intended to meet the design requirements of finished products. 
2. This evaluation board/kit or development tool is intended for use by an electronic engineer and is not a consumer product. The user should use it properly and in a safe manner. Seiko Epson does not assume any responsibility or liability of any kind of damage and/or fire 

caused by its use. The user should cease to use it when any abnormal issue occurs even during proper and safe use. 
3. Parts used for this evaluation board/kit or development tool may be changed without any notice.

NOTICE : PLEASE READ THE FOLLOWING NOTICE CAREFULLY BEFORE USING THIS DOCUMENT
The contents of this document are subject to change without notice.
1. This document may not be copied, reproduced, or used for any other purpose, in whole or in part, without the consent of the Seiko Epson Corporation (“Epson”).
2. Before purchasing or using Epson products, please contact our sales representative for the latest information and always be sure to check the latest information published on Epson’s official web sites and other sources.
3. Information provided in this document such as application circuits, programs, usage, etc., are for reference purposes only. Using the application circuits, programs, usage, etc. in the design of your equipment or systems is your own responsibility. Epson makes no 

guarantees against any infringements or damages to any third parties’ intellectual property rights or any other rights resulting from the information. This document does not grant you any licenses, intellectual property rights or any other rights with respect to Epson 
products owned by Epson or any third parties.

4. Epson is committed to constantly improving quality and reliability, but semiconductor products in general are subject to malfunction and failure. By using Epson products, you shall be responsible for your hardware. Software and systems must be designed well enough to 
prevent death or injury as well as any property damage even if any of the malfunctions or failures might be caused by Epson products. When designing your products using Epson products, please be sure to check and comply with the latest information regarding Epson 
products (this document, specifications, data sheets, manuals, Epson’s web site, etc.). When using the information included above materials such as product data, charts, technical contents, programs, algorithms and application circuit examples, you shall evaluate your 
products both on a stand-alone basis as well as within your overall systems. You shall be solely responsible for deciding whether or not to adopt and use Epson products.

5. Epson has prepared this document and programs provided in this document carefully to be accurate and dependable, but Epson does not guarantee that the information and the programs are always accurate and complete. Epson assumes no responsibility for any damages 
which you incur due to misinformation in this document and the programs.

6. No dismantling, analysis, reverse engineering, modification, alteration, adaptation, reproduction, etc., of Epson products is allowed.
7. Epson products have been designed, developed and manufactured to be used in general electronic applications (office equipment, communications equipment, measuring instruments, home electronics, etc.) and applications individually listed in this document (“General 

Purpose”). Epson products are NOT intended for any use beyond the General Purpose uses that requires particular/higher quality or reliability in order to refrain from causing any malfunction or failure leading to death, injury, serious property damage or severe impact on 
society, including, but not limited to those listed below. Therefore, you are advised to use Epson products only for General Purpose uses. Should you desire to buy and use Epson products for a particular purpose other than a General Purpose uses, Epson makes no 
warranty and disclaims with respect to Epson products, whether express or implied, including without limitation any implied warranty of merchantability or fitness for any particular purpose. Please be sure to contact our sales representative and obtain approval in advance.
【Particular purpose】

Space equipment (artificial satellites, rockets, etc.)
Transportation vehicles and their control equipment (automobiles, aircraft, trains, ships, etc.)
Medical equipment (other than applications individually listed in this document) / Relay equipment to be placed on ocean floor
Power station control equipment / Disaster or crime prevention equipment / Traffic control equipment / Financial equipment
Other applications requiring similar levels of reliability as those listed above

8. Epson products listed in this document and our associated technologies shall not be used in any equipment or systems that laws and regulations in Japan or any other countries prohibit to manufacture, use or sell. Furthermore, Epson products and our associated 
technologies shall not be used for developing weapons of mass destruction, or any other military purposes or applications. If exporting Epson products or our associated technologies, you shall comply with the Foreign Exchange and Foreign Trade Control Act in Japan, 
Export Administration Regulations in the U.S.A. (EAR) and other export-related laws and regulations in Japan and any other countries and follow the required procedures as provided by the relevant laws and regulations.

9. Epson assumes no responsibility for any damages (whether direct or indirect) caused by or in relation with your non-compliance with the terms and conditions in this document.
10. Epson assumes no responsibility for any damages (whether direct or indirect) incurred by any third party that you assign, transfer, loan, etc., Epson products to.
11. For more details or other concerns about this document, please contact our sales representative.

Company names and product names listed in this document are trademarks or registered trademarks of their respective companies. Arm, Cortex, Keil and µVision are registered trademarks of Arm Limited (or its subsidiaries) in the US and/or elsewhere. IAR Systems, IAR 
Embedded Workbench, C-SPY, I-jet, IAR and the logotype of IAR Systems are trademarks or registered trademarks owned by IAR Systems AB. SEGGER and J-Link are trademarks or registered trademarks of SEGGER Microcontroller GmbH & Co. KG. All rights 
reserved. All brands or product names mentioned herein are trademarks and/or registered trademarks of their respective companies. “Reproduced with permission from Arm Limited. Copyright © Arm Limited”
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Overview
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This reference design guide describes the demonstration 
software that reproduces the operation as a fire alarm by 
using the evaluation board of the Sound MCU “S1C31D41" 
and the sensor module.

1. Overview

S5U1C31D41T

Sensor module

Fire alarm

Sound MCU “S1C31D41" 
evaluation board
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Evaluation Board “S5U1C31D41T" 
and external Parts
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Sound MCU “S1C31D41"

2. Evaluation Board “S5U1C31D41T" and external Parts

Connector for sensor module
※With the UPMUX (Universal Port Multiplexer)
function of EPSON MCU, each connector can be
set by software for GPIO and each serial
communication (SPI, I2C, etc.).

Audio jack for *speaker

Main parts of evaluation board

Gas sensor module with MQ-2

Temperature sensor module with BME280

External parts

LED

*Default audio device
Please refer to Appendix to switch the audio device.
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Startup

～From software writing to demonstration start～
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(1)Double-click “FIREALARM_DEMO.eww" from sample software 
package (s1c31d5xd41sp_ver5_00).

Folder path : s1c31d5xd41sp_ver5_00¥Projects¥Demonstration¥FIREALARM_DEMO¥IAR

(2)After setting the jumper as shown in the figure below, connect 
the PC to the evaluation board and push SW9.

3.1 Writing Software

JP1

J7
2 1
4 3
6 5
8 7

1
3

(1)Double click

SW9

(2)Setting of board
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(3)When EWARM starts up, change the debugger to CMSIS DAP.

Project→Options→Debugger→Driver→CMSIS DAP

(4)Execute “Rebuild All"

Project→Rebuild All

3.1 Writing Software

(4)Select Rebuild All

(3)Select CMSIS DAP



11

(5)Execute “Download and Debug". If the writing is completed 
normally, the debug screen will be displayed automatically.

3.1 Writing Software

(5)Select Download and Debug

Confirm that the cursor is 
coming at the beginning 
of the main statement
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(1)As shown in the figure below, after setting the jumper and DIP 
switch, connect the PC to the evaluation board and push SW7.

3.2 Writing sound data

JP1

J7
2 1
4 3
6 5
8 7

1
3

SW7

(1)Setting of board

1 2 3 4

ON

SW8
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3.2 Writing sound data

(2)Double-click “run_write_flash_romdata.bat" from the sample 
software package (s1c31d5xd41sp_ver5_00).

Folder path : s1c31d5xd41sp_ver5_00¥Tools¥qspi_flash_writer¥FIREALARM_DEMO

(3)As shown in the lower right figure, when three “Serial Flash 
write complete normally" are displayed, the sound data writing is 
complete.

(2)Double click
(3)Writing is completed when displayed
“SerialFlash write complete normally"
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3.3 Sensor module connection

VCC
GND
SCL

CSB
SDO

SDA

12
4
6
8

10
12

3
5

7
9
11

(3)Connect the LED

(2)Connect the gas sensor

(1)Connect the temperature 
sensor

procedure

AD DO GNDVCC

1 2 3 4

1 2 3 4 5 6 7 8

Anode

(1)

(2)
(3)
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3.4 Board setting & Demonstration start

1 2 3 4

ON

SW8

JP1

J7
2 1

4 3
6 5

8 7

1
3

P10

J11

J9

JP4

JP2

JP3

1

3

1

31

3

2
1

1
2

(3)Startup is complete when 
you hear a sound from the 
speaker saying “Works properly".

(2)Connect the USB cable and 
Demonstration starts when the 
power is turned on

(1)Set the jumper and DIP 
switch of the evaluation board 
according to the figure.

procedure

Works 
properly

(1)
(2)

(3)

(1) (1)
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Function introduction
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Each sensor module plays audio when it detects gas or heat. Sensing is 
performed even during playing, and if gas and heat is no longer detected, 
playing and LED flushing is finished. Audio is played even though the 
temperature sensor is not connected.

4.1 Fire detection

Target Sentence Play pattern LED pattern

Gas Fire.Fire. Repeat Blinking

Heat Fire in the kitchen. Repeat Blinking

No connect temperature sensor Unable to measure temperature correctly. Repeat Blinking

• Image of gas detection • Image of heat detection

Fire.Fire.

Fire in the 
kitchen.
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• Detects low voltage of power supply

Plays audio when detect low voltage. If the power restored, audio play and LED flushing is finished.

• Self test
Self test of memory is performed, and the test result is notified playing audio and LED.

Self test is performed automatically when the power is turned on or when the power is reset.

• Stop playing

Push and hold SW1 on the evaluation board for 1 second during playing audio to stop playing. If you 
push SW1 again after stopping, audio will resume if there is an audio play factor (ex: Power supply 
voltage is lower power than threshold value). If there is no audio play factor, audio play will finish.

• Reset of software

With no audio playing, push and hold SW1 on the evaluation board for 1 second to reset the software.

4.2 Other function introduction

Target Sentence Play pattern LED pattern

Power supply voltage
(threshold value of default:2.7V)

Battery low. Repeat(10sec interval) Lighting

Test result Sentence Play pattern LED pattern

OK Works properly One shot

NG Blinking
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Operation overview of Sound MCU
(S1C31D41)
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By switching the internal system clock of the Sound MCU, efficient 
intermittent operation is implemented and power is reduced. It 
operates with a low-speed clock (1.8MHz) during sensing, and 
operates with a high-speed clock (16MHz) only during audio play.

5.1 Intermittent operation for low power

Isleep : Current when sleep
T : Intermittent operation cycle(1seccond)

Iplay : Current when playing audio
IRUN : Current when sensing

T

Sensing Sensing

Sleep

IRUN

Isleep

Play audio

Sleep

Iplay

Sensing

Current

Time

1.8MHz

16MHz

1.8MHz 1.8MHz

Switch system clock with audio play trigger
ex)detect heat by sensor module
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Appendix
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With the evaluation board “S5U1C31D41T", audio can be played from three 
devices: speaker, electromagnetic buzzer, and piezoelectric buzzer by 
setting the evaluation board and software.

6.1 Switching audio devices

Board setting Software setting

Enable “SPEAKER" defined in the header file 
“mid_sound_control.h" and comment out other devicesP10

J11

J9

JP4

JP2

JP3

JP1

J7
2 1
4 3
6 5
8 7

1
3

1

3

1

31

3

2
1

1
2

(1)Set jumper
(2)Connect speaker

① Speaker settings

(1)

(2)

(1)
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6.1 Switching audio devices

Enable “ELBUZZER" defined in the header file 
“mid_sound_control.h" and comment out other devices

JP1

J7
2 1
4 3
6 5
8 7

1
3

P10

J11

J9

JP4
JP2

JP3

1

3

1

31

3

2
1

1
2

(1)Set jumper

Board setting Software setting
Electromagnetic 
buzzer 

② Electromagnetic buzzer settings

(1) (1)
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6.1 Switching audio devices

Enable “PIBUZZER" defined in the header file 
“mid_sound_control.h" and comment out other devices

(1)Set jumper
(2)Connect Piezoelectric buzzer to board
※Refer to the “S5U1C31D41T Manual" for 
the settings when supplying power to the 
piezoelectric buzzer from external.

JP1

J7
2 1

4 3
6 5

8 7

1
3

P10

J11

J9

JP4

JP2

JP3

1

3

1

31

3

2
1

1
2

Board setting Software setting

③ Piezoelectric buzzer settings

Piezoelectric 
buzzer 

(2)

(1)

(1)
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① Select language ② Switching memory for sound data

6.2 Switching sound data

1 2 3 4

ON

SW8

1 2 3 4

ON

SW8

Japanese

English

Flash memory can be switched by “EXTERNAL_FLAH" 
defined in the header file “mid_sound_control.h"

• Using SPI-Flash on board

• Using internal flash of the Sound MCU “S1C31D41"

Language can be switched by setting the DIP 
switch (SW8).

*”3.2 Writing sound data" cannot be executed 
while using the internal flash.
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① Temperature sensor module ② Gas sensor module

6.3 Threshold setting for sensor module

Change the value defined in the header file 
“sensor_control.h" and set the temperature 
threshold that triggers for the audio play.
In the case of the figure below, audio play is 
executed more than 60 ° C.

Change the gas concentration setting by adjusting 
the red frame in the figure below. Turning it 
clockwise lowers the gas concentration threshold 
that triggers for the audio play, and turning it 
counterclockwise raises the threshold.

AD DO GND VCC

Direction where 
the threshold 

goes down
(Clockwise)

※When the threshold is lowered 
to the maximum,audio may be 
played at all times
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Change the value defined in the header file “mid_battery.h" to set 
the threshold value for detecting the low power supply voltage 
that triggers audio play. For the relationship between the set value 
and the detected voltage value, refer to the S1C31D41 
manual.(23.8 Supply Voltage Detector (SVD3) Characteristics)

6.4 Threshold setting for detect low voltage
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The self test function can be expanded (checksum in the Flash area) by 
setting the software. The target Flash area is the internal flash and the 
SPI-Flash on board. * If the audio Flash memory is set to the internal flash, 
the SPI-Flash does not perform self test.
* Refer to “6.2 Switching sound data" in this document.

(1)Delete comment out(//) of  “MEMCHECK_FLASH" defined in the source file "main.c“ to enable it.

(2)Start a debug session and follow the steps below to open a register window.

View→Registers→Register 1

(3)After the register window opens, select “MEMCHECK" from the tab (Group) in the red frame in the 
figure.

6.5 Self test of Flash area (checksum)

Register window

(1)Delete”//" to enable (2)Open register window

(3)Select MEMCHECK
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(4)As shown in the figure below, set two breakpoints in the source file “main.c” and execute the program.

(5)Check the register value “RESULT" at the two breakpoints when it is stopped, and rewrite the initial value 
of the variable in the figure below.

Stop at the top of the breakpoint in the figure below → Check the checksum of the SPI-Flash on the board 
from “RESULT" and change the initial value of the variable.

Stop at the bottom of the breakpoint in the figure below → Check the checksum of the internal flash from 
“RESULT" and change the initial value of the variable

※If it is not  stopped at the breakpoint, it is not necessary to rewrite the initial value.

※If enabled self-test in the Flash area and changed the code or audio data, please rewrite the initial value 
each time.

6.5 Self test of Flash area (checksum)

(4)Set break point
(For SPI-Flash on the board)

(4)Set break point
(For internal flash)

(5) Set the value displayed in RESULT at each 
breakpoint to the initial value of the variable 

for the checksum of each Flash.

Initial value of checksum variable (checksum_exflash) for  
SPI-Flash on board

Initial value of checksum variable (checksum_flash) for 
internal flash
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• Reference manual

7. Reference manual

Reference information Document Location

Sound MCU 「S1C31D41」 • S1C31D41 Technical Manual

HP

Evaluation board
「S5U1C31D41T」

• S5U1C31D41T Manual

Writing software

• S1C31 Family Software 
Development Setup Guide

• S1C31 Family Sample Software 
Manual

https://global.epson.com/products_and_drivers/semicon/products/micro_controller/armcore/index.html
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